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Compliance information

NOTICE: This laboratory equipment has been tested and found to comply with the EMC and the Low 
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1
About this guide

This chapter covers the following topics:

• What this guide covers (page 10)

• Conventions (page 11)

• About the documentation (page 11)

• Instrument technical support (page 13)
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User’s Guide10

What this guide covers
This guide describes the procedures necessary to operate and 
maintain the following Special Order Research Product (SORP) 
flow cytometers:

• BD LSRFortessa™ X-30

• BD LSRFortessa™ X-50

• BD LSRFortessa™ X-30 Dual

• BD FACSymphony™ A3

• BD FACSymphony™ A5

• BD FACSymphony™ A3 Dual

BD Biosciences changed the names of the BD LSRFortessa X-30, 
X-50, and X-30 Dual flow cytometer models to BD FACSymphony 
A3, A5, and A3 Dual, respectively. 

Because many cytometer functions are controlled by 
BD FACSDiva™ software, this guide also contains information 
about software features required for basic cytometer setup and 
operation. 

This guide assumes you have a working knowledge of basic 
Microsoft® Windows® operation. If you are not familiar with the 
Windows operating system, see the documentation provided with 
your computer.

Cytometer old name Cytometer new name

BD LSRFortessa X-30 BD FACSymphony A3

BD LSRFortessa X-50 BD FACSymphony A5

BD LSRFortessa X-30 Dual BD FACSymphony A3 Dual
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Chapter 1: About this guide 11

Conventions
Introduction The following table lists the safety symbols used in this guide to 

alert you to potential hazards.

Safety symbols

About the documentation
Introduction This topic describes the documentation available with the 

BD LSRFortessa X-30, BD LSRFortessa X-50, BD LSRFortessa X-
30 Dual, BD FACSymphony A3, BD FACSymphony A5, and 
BD FACSymphony A3 Dual flow cytometers.

The following list includes the available documentation for the 
system.

• BD FACSDiva Software Reference Manual: Includes 
instructions or descriptions for installation and setup, 
workspace components, acquisition controls, analysis tools, 

Symbol Meaning

Caution alert

Identifies a hazard or unsafe practice that could result in data 
loss, material damage, minor injury, severe injury, or death

Biological hazard

Electrical hazard

Laser hazard
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and data management. Access this manual from the 
BD FACSDiva Software Help menu (Help > Documentation > 
Reference Manual), or by double-clicking the shortcut on the 
desktop. 

• BD Cytometer Setup and Tracking Application Guide: 
Describes how to use the BD™ Cytometer Setup and Tracking 
(CS&T) features in BD FACSDiva software.

• The BD LSRFortessa X-30, BD LSRFortessa X-50, 
BD LSRFortessa X-30 Dual, BD FACSymphony A3, 
BD FACSymphony A5, and BD FACSymphony A3 Dual Flow 
Cytometers Site Preparation Guide: Contains specifications 
for:

– Cytometer weight and size

– Temperature and other environmental requirements

– Electrical requirements

• The BD LSRFortessa X-30, BD LSRFortessa X-50, 
BD LSRFortessa X-30 Dual, BD FACSymphony A3, 
BD FACSymphony A5, and BD FACSymphony A3 Dual Flow 
Cytometers Safety and Limitations: Provides descriptions of 
safety and warning labels, general system hazards, specific 
risks, and laser, electrical, and biological hazards.

• BD High Throughput Sampler User’s Guide: Describes how to 
set up and operate the BD™ High Throughput Sampler (HTS) 
option. It also contains a description of BD FACSDiva 
software features specific to the HTS.

• BD FACSFlow™ Supply System User’s Guide: Describes the 
optional automated sheath and waste fluid control system.

Publication formats This guide is provided in PDF format to provide an eco-friendly 
option. 
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Chapter 1: About this guide 13

Instrument technical support
Introduction This topic describes how to get technical assistance.

Contacting 
technical support

If technical assistance is required, contact your local 
BD Biosciences customer support representative or supplier. Visit 
our website bdbiosciences.com for up-to-date contact information.

When contacting BD Biosciences, have the following information 
available:

• Product name, part number, and serial number

• Version of BD FACSDiva software you are using

• Any error messages

• Details of recent system performance

More information • What this guide covers (page 10)
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2
Introduction

This chapter covers the following topics:

• System overview (page 16)

• Cytometer overview (page 18)

• Control panel (page 22)

• Fluidics system (page 23)

• Sheath and waste containers (page 30)

• Optics (page 31)

• Workstation (page 33)

Status: Released EFFECTIVEDocument: 23-17876-00 Doc Type: ZLU
Change #: 500000105151Revision: 01

Version: AUsage: Production Usage Classification: ConfidentialPrint Date: 19-Jan-2018 05:14:57 GMT Standard Time
Valid From: 05-Sep-2017 To: 31-Dec-9999 Doc Part: EN



User’s Guide16

System overview
About the system The BD LSRFortessa X-30, BD LSRFortessa X-50, 

BD LSRFortessa X-30 Dual, BD FACSymphony A3, 
BD FACSymphony A5, and BD FACSymphony A3 Dual system 
includes the flow cytometer, BD FACSDiva software v8.0.1.1 
running on the system workstation, the optional BD FACSFlow™ 
supply system (FFSS), and the optional BD High Throughput 
Sampler (HTS). Each component is described in detail in the 
following sections.

BD FACSymphony A3 system

1 2 3

Number Components

1 Sheath and waste tanks

2 BD FACSymphony A3 flow cytometer

3 Computer workstation
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Chapter 2: Introduction 17

BD FACSymphony A5 system

1 2 3

Number Components

1 Sheath and waste tanks

2 BD FACSymphony A5 flow cytometer

3 Computer workstation
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BD FACSymphony A3 Dual system

Cytometer overview
Introduction The BD LSRFortessa X-30, BD LSRFortessa X-50, 

BD LSRFortessa X-30 Dual, BD FACSymphony A3, 
BD FACSymphony A5, and BD FACSymphony A3 Dual flow 
cytometers are air-cooled multi-laser benchtop flow cytometers 
with the ability to acquire parameters for a large number of colors. 
They use fixed-alignment lasers that transmit light through a flow 
cell to polygon/decagon detector arrays. These detectors collect 
and translate the resulting fluorescence signals into electronic 
signals. Cytometer electronics convert these signals into digital 
data.

1 2 3

Number Components

1 Sheath and waste tanks

2 BD FACSymphony A3 Dual flow cytometer

3 Computer workstation
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Chapter 2: Introduction 19

Components The following figures show the main components of the each 
instrument. Each component is described in detail in the following 
sections.

BD FACSymphony A3

8
2

3

6

4

5

9

7

1

Number Component Number Component

1 Heat ventilation slots (top) 6 Sample injection port (SIP)

2 Control panel 7 Heat ventilation slots (side)

3 Power button 8 Air and fluidic ports

4 Electrical plug 9 Optics access door (polygon/
decagon detector arrays) left side

5 Fluidic sensors
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BD FACSymphony A5

1

7

2
3

4

5

6

9 8

Number Component Number Component

1 Heat ventilation slots (top) 6 Sample injection port (SIP)

2 Control panel 7 Heat ventilation slots (side)

3 Power button 8 Air and fluidic ports

4 Electrical plug 9 Optics access doors (polygon/
decagon detector arrays)

5 Fluidic sensors
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Chapter 2: Introduction 21

BD FACSymphony A3 Dual

6

5

1

2

3

4

7

8
9

Number Component Number Component

1 Heat ventilation slots (top) 6 Sample injection port (SIP)

2 Control panels 7 Heat ventilation slots (side)

3 Power button 8 Air and fluidic ports

4 Electrical plug 9 Optics access door (polygon/
decagon detector arrays)

5 Fluidic sensors
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Control panel
Overview The following figure shows the components in the control panel, 

which are listed in the table.

Caution! Do not place any objects on top of the 
instrument. Blocking the ventilation may cause the 
instrument to overheat.

Caution: Electrical Hazard! Do not place liquids on top of 
the instrument. Any spill of liquid into the ventilation 
openings could cause electrical shock or damage to the 
instrument.

1 2

3 4 6

5

Number Component

1 System indicators

2 Fluid control buttons

3 Sample flow rate buttons

Status: Released EFFECTIVEDocument: 23-17876-00 Doc Type: ZLU
Change #: 500000105151Revision: 01

Version: AUsage: Production Usage Classification: ConfidentialPrint Date: 19-Jan-2018 05:14:57 GMT Standard Time
Valid From: 05-Sep-2017 To: 31-Dec-9999 Doc Part: EN



Chapter 2: Introduction 23

More information • Fluidics system (page 23)

• Optics (page 31)

Fluidics system
Introduction The fluidics system carries the sample out of the sample tube and 

into the sensing region of the flow cell. Cells are carried in the 
sample core stream in single file and measured individually.

System indicators There are two system indicators (System status and Activity) on the 
control panel.

• System status. Shows the status of the sheath and waste tank 
levels. The following table describes the LED indicators, 
conditions that trigger them, and any action that must be 
taken.

4 Sample fine adjust buttons

5 Status screen

6 Mode button

Number Component

LED color Status Action

Green Good None

Yellow Caution!  Sheath and 
waste tanks need 
attention.

Check tank levels

Red Caution!  Take immediate 
action.

 Empty waste tank

 Fill sheath tank
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System status is also displayed on the Status screen. See Status 
screen (page 26) for a description of the Status screen.

• Activity. Shows whether the cytometer power is on and the 
status of acquisition. The following table describes the 
indicator LEDs, and the status that triggers them.

Fluid control The three fluid control buttons (Run, Standby, and Prime) set the 
cytometer operation.

• Run. Pressurizes the sample tube to transport the sample 
through the sample injection tube and into the flow cell.

The Run button is green when the sample tube is on and the 
support arm is centered. When the tube support arm is moved 
left or right to remove a sample tube, the cytometer switches to 
an automatic standby status to conserve sheath fluid, and the 
Run button changes to orange.

• Standby. Stops fluid flow to conserve sheath fluid.

When you leave the cytometer for more than a few minutes, 
place a tube containing 1 mL of deionized (DI) water on the 
sample injection port (SIP) and press Standby.

• Prime. Prepares the fluidics system by draining and filling the 
flow cell with sheath fluid.

The fluid flow initially stops, and pressure is reversed to force 
fluid out of the flow cell and into the waste container. After a 
preset time, the flow cell fills with sheath fluid at a controlled 
rate to prevent bubble formation or entrapment. At 
completion, the cytometer switches to standby mode.

Indicator LED color Status

Steady pulse blue Cytometer is powered on.

Fluctuates blue Cells are passing through the 
flow cell.
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Sample flow rate 
control

The three flow rate control buttons (LOW, MED, HIGH) set the 
sample flow rate through the flow cell. The SAMPLE ADJ buttons 
allow you to adjust the rate to intermediate levels.

When sample adj is set to 250 (as shown on the status screen on 
the control panel) the sample flow rates at the low, med, and high 
settings are approximately 12, 35, and 60 µL/min of sample, 
respectively. Each time you press one of the SAMPLE ADJ buttons, 
the fine adjust of the indicated sample increases or decreases by 10. 
The following table shows the approximate sample flow rate range 
for low, medium, and high.

Number Component

1 Status screen

2 Sample flow rate buttons

3 Sample fine adjust buttons

Settings Sample flow rate (µL/min)

Low 6–24

Med 17.5–70

High 30–120

2

1

3
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Status screen The first two lines of the status screen show the level of the waste 
and sheath tanks. The third line toggles between three different 
displays and is described in detail in the following table.

12

3

4
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Fluidic alarms and 
the Mode button

The fluidic alarms are triggered by the waste and sheath fluid levels 
in the tanks. The alarms sound when the waste tank is nearly 
100% full and the sheath tank is empty. 

To silence the alarm, press the Mode button, then press the Down 
button. The Mode button flashes to indicate the cytometer is in 
silent mode. Repeat this sequence to turn off silent mode.

Note:  When the cytometer is in FFSS mode, the alarms are 
deactivated. 

Line Definition

1 Waste level. Shows range (1) from E (empty) to F (full). The 
display line increases from left to right in sequences of 20%. 
System status turns yellow at 80%, and red at 100% full.

2 Sheath level. Shows range from E to F. The display line 
decreases from right to left in sequences of 20% from 
full level. System status turns yellow at 20%, and red at 
0%.

3 Fine Adj. Shows the current setting of fine adjust. Fine 
adjust can be set in increments of 10 from 0 to 500. The 
last value persists, even after cytometer shutdown.

Air pressure. Shows the air pressure as either greater 
than (>) 5.4 psi, or less than (<) 5 psi. To display psi, 
press the Mode button, followed by the Up button.

4 FFSS Mode. Shows that the cytometer is in FFSS mode. 
To enter this mode, press the MODE button 4 times. 
After you reach FFSS OFF, push the SAMPLE ADJ 
button once. You should now see the panel display FFSS 
ON. To exit, press the MODE button 4 times, then 
SAMPLE ADJ button once. Repeat the process to turn 
FFSS off.
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Sample injection 
port

The SIP is where the sample tube is installed. The SIP includes the 
sample injection tube and the tube support arm. Samples are 
introduced through a stainless steel injection tube equipped with 
an outer droplet containment sleeve. The sleeve works in 
conjunction with a vacuum pump to eliminate droplet formation 
of sheath fluid as it backflushes from the sample injection tube.

Sample injection tube. Stainless steel tube that carries sample from 
the sample tube to the flow cell. This tube is covered with an outer 
sleeve that serves as part of the droplet containment system.

Tube support arm. Arm that supports the sample tube and 
activates the droplet containment system vacuum. The vacuum is 
on when the arm is positioned to the side and off when the arm is 
centered.

Note:  If a sample tube is left on the SIP with the tube support arm 
to the side (vacuum on), the sample will be aspirated into the waste 
container.

Outer sleeve

Sample injection tube

Tube support arm
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Cautions when 
using the HTS 
option

Droplet 
containment 
module

The DCM prevents sheath fluid from dripping from the SIP and 
provides biohazard protection.

When no sample tube is installed on the SIP, sheath fluid 
backflushes through the sample injection tube. This backflush 
helps prevent carryover of cells between samples. The DCM 
vacuum is activated when the sample tube is removed and the tube 
support arm is moved to the side. Sheath fluid is aspirated as it 
backflushes the sample injection tube.

Caution: Biohazard! When using the flow cytometers with 
the HTS, ensure that the HTS is completely pushed into 
the operating position before removing the droplet 
containment module (DCM) sleeve or disconnecting the 
sample coupler from the SIP. This is to avoid accidental 
leakage of potentially biohazardous liquids directly onto 
the instrument. With the HTS in the proper location, the 
containment dish with padding is directly below the SIP.

Caution! If you are using the HTS option, always slide 
the HTS mount slowly to prevent sample cross-
contamination when the wells are full. Never move the 
HTS when it is in operation.

Caution! Do not lean on or put any weight on the HTS as 
it could damage the instrument.
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Sheath and waste containers
Introduction This topic describes the sheath and waste containers. The sheath 

and waste containers are outside the cytometer and are positioned 
on the floor.

Note:  If you are using the FFSS, see the documentation provided.

Sheath container The sheath container has a capacity of 10 L. Sheath fluid is filtered 
through an in-line, interchangeable filter that prevents small 
particles from entering the sheath fluid lines. An alarm sounds 
when the container is full.

Waste container The waste container has a capacity of 10 L. An alarm sounds when 
the container is full.

More information • Preparing the sheath container (page 37)

• Preparing the waste container (page 42)

• Status screen (page 26)

• Fluidic alarms and the Mode button (page 27)

Caution! Do not fill the sheath tank to its maximum 
capacity. When an overfull tank is pressurized, erratic 
cytometer performance can result.
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Optics
Introduction This topic describes the optical components for the 

BD LSRFortessa X-30, BD LSRFortessa X-50, BD LSRFortessa X-
30 Dual, BD FACSymphony A3, BD FACSymphony A5, and 
BD FACSymphony A3 Dual flow cytometers including:

• Detector arrays

• Laser options

• Optical filters

• Signal detectors

Detector arrays The detector arrays consist of polygons/decagons. Each polygon/
decagon can be outfitted with two to 10 PMTs and can detect up 
to 10 signals.

Laser options The flow cytometers can be configured with up to five lasers as 
listed in the following table. 

 

Laser Wavelength (nm) Power (mW)

Violet (standard) 405 250

Blue (standard) 488 400

UV (standard) 355 100

Yellow Green (standard) 561 300

Green (optional) 532 1000

Red (optional) 640 100

Red (standard) 637 140

Red (optional) 628 1000
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Optical filters Optical filters attenuate light or help direct it to the appropriate 
detectors. The name and spectral characteristics of each filter 
appear on its holder.

There are two types of optical filters in the BD LSRFortessa X-30, 
BD LSRFortessa X-50, BD LSRFortessa X-30 Dual, 
BD FACSymphony A3, BD FACSymphony A5, and 
BD FACSymphony A3 Dual flow cytometers:

• Longpass dichroic filters (LPs). Transmit wavelengths that are 
longer than the specified value and reflect all light below the 
specified wavelength.

• Bandpass filters (BPs). Pass a narrow spectral band of light.

When dichroic filters are used as steering optics to direct different 
color light signals to different detectors, they are called dichroic 
mirrors. LP dichroic mirrors transmit longer wavelengths to one 
detector while reflecting shorter wavelengths to a different detector.

The flow cytometer polygon/decagon detector arrays use dichroic 
longpass mirrors on the inside, and bandpass filters on the outside 
of the filter holders.

filter holder
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Signal detectors Light signals are generated as particles pass through the laser beam 
in a fluid stream. When these optical signals reach a detector, 
electrical pulses are created that are then processed by the 
electronics system.

There are two types of signal detectors in the BD LSRFortessa X-
30, BD LSRFortessa X-50, BD LSRFortessa X-30 Dual, 
BD FACSymphony A3, BD FACSymphony A5, and 
BD FACSymphony A3 Dual flow cytometers: 

• Photomultiplier tubes (PMTs).  Used to detect the weaker 
signals generated by side scatter and all fluorescence channels. 
These signals are amplified by applying a voltage to the PMTs. 

• Photodiodes.  Less sensitive to light signals than the PMTs. A 
photodiode is used to detect the stronger forward scatter (FSC) 
signal.

Workstation
Introduction This topic describes the components of the  workstations.

Workstation 
components

Acquisition, analysis, and most instrument functions are controlled 
by the workstations. They include a PC, one or two monitors, and 
a printer. Your workstation is equipped with the following:

• Microsoft Windows operating system

• BD FACSDiva software version 8.0.1.1 or later for data 
acquisition and analysis 

• Software documentation including the help system
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3
Cytometer setup

This chapter covers the following topics:

• Starting the cytometer and computer (page 36)

• Preparing the sheath container (page 37)

• Removing air bubbles (page 39)

• Preparing the waste container (page 42)

• Priming the fluidics (page 44)

• About the optical filters and mirrors (page 45)

• Custom configurations and baselines (page 47)
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Starting the cytometer and computer
Introduction This topic describes how to start the cytometer and turn on the 

computer.

Note:  If your system is using the FFSS, make sure that the FFSS is 
powered on before the cytometer.

Procedure To start the cytometer:

1. Turn on the power to the flow cytometer. 

2. Allow 30 minutes for the optical system temperature to 
stabilize.

3. Turn on the computer and log in to Windows.

Note:  You can turn on the power to the flow cytometer and 
the workstation in any order.

4. Start BD FACSDiva software by double-clicking the shortcut 
on the desktop, and log in to the software.

5. Check the Cytometer window in BD FACSDiva software to 
ensure that the cytometer is connected to the workstation.

The cytometer connects automatically. While connecting, the 
message Cytometer Connecting is displayed in the status area 

Caution! Failure to warm up and stabilize the 
instrument could affect sample data.
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of the Cytometer window. When connection completes, the 
message changes to Cytometer Connected.

If the message Cytometer Disconnected appears, see 
Electronics troubleshooting (page 112).

Preparing the sheath container
Introduction This topic describes how to prepare the sheath container. 

Note:  If your system is using the FFSS, see the documentation 
provided with your system.

When to check the 
sheath container

Check the fluid levels in the sheath container every time you use 
the cytometer. This ensures that you do not run out of sheath fluid 
during an experiment.
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Sheath container 
components

The sheath container components are shown below.

Procedure To prepare the sheath container:

1. Verify that the flow cytometer is in standby mode. 

Press the STANDBY button on the control panel if necessary.

2. Disconnect the green air line, sheath fluid line, and alarm 
sensor from the sheath container.

3. Depressurize the sheath container by pulling up on the vent 
valve.

4. Remove the sheath container lid. 

Unscrew the clamp knob and push down to loosen, if 
necessary. Tilt the cap to the side to remove it from the tank.

Air line (green)

Sheath fluid line (blue) 
to cytometer

Filter assembly

Cap handle

Vent valve

Clamp knob

Alarm sensor
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5. Add 10 L of sheath fluid, such as BD FACSFlow™ solution, to 
the sheath container. 

Note:  The 10 L will reach the interior line on the sheath tank. 
Do not fill the sheath tank further.

6. Replace the sheath container lid. 

7. Reconnect the green air line and the alarm line.

8. Make sure the gasket on the inside lip of the sheath lid is 
seated correctly and has not slipped out of position.

If the gasket is not seated correctly, the tank will not pressurize 
properly. 

9. Close the sheath lid and tighten the clamp knob to finger-tight. 
Ensure that the blue sheath fluid line is not kinked.

More information • Removing air bubbles (page 39)

• Changing the sheath filter (page 58)

• Cleaning or replacing the sheath gasket (page 64)

Removing air bubbles
Introduction This topic describes how to remove trapped air bubbles in the 

sheath filter and the sheath line. Air bubbles can occasionally 
dislodge and pass through the flow cell, resulting in inaccurate 
data.

Note:  Perform this activity every time the sheath tank is refilled. 
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Procedure To remove air bubbles:

1. Check the sheath filter for trapped air bubbles.

2. If bubbles are visible, gently tap the filter body with your 
fingers to dislodge the bubbles and force them to the top.

Caution! When removing air bubbles, do not 
vigorously shake, bend, or rattle the sheath filter or 
you might damage it.

Vent line

Vent fitting

Cytometer fluid line 
(roller clamp not visible)
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3. Direct the vent line into a beaker and press the small button at 
the end of the vent fitting against the side of the beaker until a 
steady stream of fluid empties from the filter.

4. Tilt the filter and verify that no trapped air remains in the 
filter. 

5. Repeat steps 3 and 4 until no air is observed in the filter.

6. Check the sheath line for air bubbles.

7. Open the roller clamp at the fluidics interconnect (if necessary) 
to bleed off any air in the line. Collect any excess fluid in a 
waste container.

8. Close the roller clamp.

Button

Vent fitting
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Preparing the waste container
Introduction This topic describes how to prepare the waste container. Prevent 

waste overflow by emptying the waste container daily or whenever 
the system status indicator turns yellow.

Note:  If your system is connected to the FFSS, see the 
documentation provided with your FFSS.

Waste container 
components

The following figure shows the main components of the waste 
container.

Caution: Biohazard! All biological specimens and 
materials coming into contact with them are considered 
biohazardous. Handle as if capable of transmitting 
disease. Dispose of waste using proper precautions and in 
accordance with local regulations. Never pipette by 
mouth. Wear suitable protective clothing, eyewear, and 
gloves.

Alarm sensor

Waste fluid 
line with 
metal clip

Air line
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Biological 
precautions

To prevent exposure to biohazardous agents:

• Put the cytometer in standby mode before disconnecting the 
waste tank to avoid leakage of biohazardous waste.

• Always disconnect the waste container from the cytometer 
before you empty it. Wait at least 30 seconds for pressure to 
dissipate before you remove the waste cap or sensor.

• Expose waste container contents to bleach (10% of total 
volume) for 30 minutes before disposal.

• Do not wet the waste tank cap. If wet, the filter in the cap will 
cause the tank to malfunction. To keep the cap dry, place it on 
the bench label side up when it is not on the tank. 

Procedure To prepare the waste container:

1. Verify that the flow cytometer is in standby mode. 

Press the STANDBY button on the control panel if necessary.

2. Disconnect the orange waste tubing and the black alarm 
sensor line from the waste container. 

Keep the lid on the waste container until you are ready to 
empty it.

3. Empty the waste container.

4. Add approximately 1 L of bleach to the waste container and 
close it.

5. Reconnect the orange waste tubing and make sure it is not 
kinked.

6. Reconnect the black alarm sensor line.

Caution: Biohazard! Contact with biological specimens 
and materials can transmit potentially fatal disease.

Caution! The waste container is heavy when full. 
When emptying it, use good body mechanics to 
prevent injury.
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Priming the fluidics
Introduction This topic describes how to prime the fluidics system.

When to prime the 
fluidics

Sometimes, air bubbles and debris may become lodged in the flow 
cell. This is indicated by excessive noise in the forward and side 
scatter parameters (FSC and SSC, respectively). In these cases, it is 
necessary to prime the fluidics system.

Procedure To prime the fluidics:

1. Move the tube support arm to the side.

2. Remove the tube from the SIP.

3. Press the PRIME fluid control button to force the fluid out of 
the flow cell and into the waste container.

Once drained, the flow cell automatically fills with sheath fluid 
at a controlled rate to prevent bubble formation or 
entrapment. The STANDBY button turns amber after 
completion.

4. Repeat the priming procedure, if necessary.

5. Install a 12 x 75-mm tube with 1 mL of DI water on the SIP 
and place the support arm under the tube. Leave the cytometer 
in standby mode.

More information • Cytometer troubleshooting (page 104)
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About the optical filters and mirrors
Introduction This topic provides a description of the optical filters and mirrors.

Filter and mirror 
configurations

Each PMT has an optic holder in front of it. The optic holders are 
labeled with numbers indicating the wavelengths of the bandpass 
filter and longpass dichroic mirror they contain (for example, 780/
60 and 750 LP, respectively). The optic holder in front of the last 
PMT in the detector array contains only a bandpass filter and is 
marked accordingly.

The filters steer progressively shorter wavelengths of light to the 
next PMT in the array as indicated by the lines and arrows on the 
top of the polygon/decagon.

Optic holders, 
filters, and mirrors

Optic holders house filters and mirrors. Your cytometer includes 
several blank (empty) optic holders. 

PMT 

Optic holder 
handle

Optic holders

Caution! To ensure data integrity, do not leave any slots 
empty in a detector array when you are using the 
associated laser. Always use a blank optic holder.
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Base configurations Each flow cytometer has a base cytometer configuration that 
corresponds to the layout of the installed lasers and optics in your 
cytometer. This base configuration is set by your field service 
engineer.

BD FACSDiva 
cytometer 
configuration

Before you acquire data using BD FACSDiva software, you must 
specify a cytometer configuration. The cytometer configuration 
defines which filters and mirrors are installed at each detector.

BD FACSDiva software provides a BD base configuration for your 
flow cytometer. Select Cytometer > View Configuration to create, 
modify, or delete custom cytometer configurations. (See the 
Cytometer and Acquisition Controls chapter of the BD FACSDiva 
Software Reference Manual for details.) 
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Custom configurations and baselines
Introduction This topic describes where to find information on how to create a 

custom configuration and define a baseline for a performance 
check.

Overview BD Cytometer Setup and Tracking (CS&T) software is used to 
define the baseline performance of your cytometer. A baseline 
provides a starting point for the tracking of cytometer 
performance. When running a performance check, you compare 
the results to the baseline.

See Optimizing cytometer settings (page 65). Please see the latest 
published filter guides available on our website 
(bdbiosciences.com) for more information. 

See the BD Cytometer Setup and Tracking Application Guide for 
information on creating custom configurations and defining a 
baseline.

More information • Running a performance check (page 70)
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4 
Maintenance

This chapter covers the following topics:

• Maintenance overview (page 50)

• Cleaning the fluidics (page 51)

• Shutting down the cytometer (page 53)

• Flushing the system (page 54)

• Replacing the waste container cap (page 56)

• Changing the sheath filter (page 58)

• Changing the Bal seal (page 60)

• Changing the sample tube O-ring (page 62)

• Cleaning or replacing the sheath gasket (page 64)
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Maintenance overview
Introduction This topic provides an overview of the flow cytometer routine 

maintenance and cleaning procedures.

General use 
guidelines

Follow these guidelines whenever operating or maintaining the 
cytometer:

• Wear suitable protective clothing, eyewear, and gloves.

• Handle all biological specimens and materials in accordance 
with applicable regulations and manufacturer specifications.

• Dispose of waste using proper precautions and in accordance 
with local regulations.

• Never pipette by mouth.

For fluidics maintenance, we recommend the following cleaning 
solutions: 

• BD™ FACSClean solution

• BD™ FACSRinse solution

• 10% bleach solution

Use DI water to dilute bleach to appropriate concentrations. 

Caution: Biohazard! Contact with biological specimens 
and materials can transmit potentially fatal disease. 

Caution! Higher concentrations of sodium hypochlorite 
and use of other cleaning solutions might damage the 
cytometer.
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When to perform 
maintenance 
procedures

Perform maintenance procedures in the following frequencies.

Cleaning the fluidics
Introduction This topic describes how to perform the daily fluidics cleaning.

Overview Cleaning the fluidics daily prevents the sample injection tube from 
becoming clogged and removes dyes that can remain in the tubing. 

In addition to daily cleaning, follow this procedure immediately 
after running viscous samples or nucleic acid dyes such as Hoechst, 
DAPI, propidium iodide (PI), acridine orange (AO), or thiazole 
orange (TO).

Procedure To clean the fluidics:

1. Press RUN and HIGH on the cytometer fluid control panel. 

2. Install a tube containing 3 mL of a cleaning solution on the SIP 
with the support arm to the side (vacuum on) and let it run for 
1 minute.

Frequency Maintenance procedure

Daily  Cleaning the fluidics (page 51)

 Shutting down the cytometer (page 53)

Scheduled (every 
two weeks)

 Flushing the system (page 54)

Periodic (frequency 
depends on how 
often you run the 
cytometer)

 Changing the sheath filter (page 58)

 Changing the Bal seal (page 60)

 Changing the sample tube O-ring (page 62)

 Cleaning or replacing the sheath gasket 
(page 64)
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For the cleaning solution, use BD FACSClean solution. See 
Maintenance overview (page 50) for other recommended 
cleaning solutions.

3. Move the tube support arm under the tube (vacuum off) and 
allow the cleaning solution to run for 5 minutes with the 
sample flow rate set to HIGH.

4. Repeat steps 2 and 3 with BD FACSRinse solution.

5. Repeat steps 2 and 3 with DI water.

6. Press the STANDBY button on the fluidics control panel.

7. Place a tube containing no more than 1 mL of DI water on the 
SIP.

A tube with 1 mL of DI water should remain on the SIP to 
prevent salt deposits from forming in the injection tube. This 
tube also catches back drips from the flow cell.

Caution! Do not leave more than 1 mL of water on 
the SIP. When the instrument is turned off or left in 
standby mode, a small amount of fluid will drip back 
into the sample tube. If there is too much fluid in the 
tube, it could overflow and affect the cytometer 
performance.
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Shutting down the cytometer
Introduction This topic describes how to shut down the cytometer. 

Before you begin Each time you shut down the cytometer, perform the daily cleaning 
as described in Cleaning the fluidics (page 51).

Procedure To shut down the cytometer:

1. Place a tube of DI water on the SIP.

2. Turn off the flow cytometer.

3. Select Start > Shutdown to turn off the computer (if needed).

4. If your system is connected to the FFSS, shut off the FFSS.

If the cytometer will not be used for a week or longer, perform a 
system flush and leave the fluidics system filled with DI water to 
prevent saline crystals from clogging the fluidics.

More information • Cleaning the fluidics (page 51)

• Flushing the system (page 54)
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Flushing the system
Introduction This topic describes how to perform an overall fluidics cleaning to 

remove debris and contaminants from the sheath tubing, waste 
tubing, and flow cell. Perform the system flush at least every 
2 weeks.

Note:  If you are using the FFSS, see the BD FACSFlow Supply 
System User’s Guide for instructions on flushing the system.

Cautions

Procedure To perform a system flush:

1. Remove the sheath filter.

a. Press the quick-disconnects on both sides of the filter 
assembly.

b. Remove the filter assembly.

c. Connect the two fluid lines.

2. Empty the sheath container and rinse it with DI water.

3. Fill the sheath container with at least 1 L of undiluted 
BD FACSClean solution.

4. Empty the waste container, if needed.

5. Open the roller clamp by the fluidics interconnect, and drain 
the fluid into a beaker for 5 seconds.

6. Remove the DI water tube from the SIP.

Caution: Biohazard! The cytometer hardware might be 
contaminated with biohazardous material. Use 10% 
bleach to decontaminate the instrument. 

Caution! Do not run detergent, bleach, or ethanol 
through the sheath filter. They can break down the 
filter paper within the filter body, causing particles to 
escape into the sheath fluid, possibly clogging the 
flow cell.
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7. Prime the instrument twice:

a. Press the PRIME button on the fluidics control panel. 

b. When the STANDBY button lights (amber), press the 
PRIME button again.

8. Install a tube with 3 mL of undiluted BD FACSClean solution 
on the SIP and put the tube support arm underneath the tube.

See Maintenance overview (page 50) for other recommended 
cleaning solutions.

9. Press RUN and HIGH on the cytometer fluid control panel. 
Run for 30 minutes.

10. Press the STANDBY fluid control button and depressurize the 
sheath container by lifting the vent valve.

11. Repeat steps 2 through 10 with BD FACSRinse solution.

12. Repeat steps 2 through 10 with DI water.

13. Replace the sheath filter and refill the sheath container with 
sheath fluid.
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Replacing the waste container cap
Introduction This topic describes how to replace the waste container cap. 

Replace the cap once a month.

Biological 
precautions

To prevent exposure to biohazardous agents:

• Put the cytometer in standby mode before disconnecting the 
waste tank to avoid leakage of biohazardous waste.

• The waste container can become pressurized when the 
cytometer is running. Always disconnect the waste container 
from the cytometer before you empty it. Wait at least 
30 seconds for pressure to dissipate before you remove the 
waste cap or sensor.

• Expose waste container contents to bleach (10% of total 
volume) for 30 minutes before disposal.

Procedure To replace the cap:

1. Put the cytometer in standby mode.

2. Disconnect the waste container’s sensor line and orange waste 
line from the waste container tank, and wait at least 
30 seconds for pressure to dissipate.

3. Remove the waste cap and attached trap from the container 
and place on the bench label-side up.

4. Detach the cap from the trap.

5. Place a new cap on the trap.

Caution: Biohazard! Contact with biological specimens 
and materials can transmit potentially fatal disease.
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6. Write the date on the cap label.

7. Screw the cap assembly onto the waste container and hand-
tighten until it is fully closed.

Re-attach the alarm sensor line and waste line to the waste 
container tank.

Caution: Biohazard! To prevent waste container 
overpressurization, do not overtighten the trap or 
attached filter cap. Tighten each component only until it 
is hand-tight. Do not use sealants such as Teflon® tape 
or other adhesives.

338677 Rev A

Waste (A)
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Changing the sheath filter
Introduction This topic describes how to change the sheath filter. The sheath 

filter is connected in-line with the sheath line. It filters the sheath 
fluid as it comes from the sheath container. 

When to change 
the sheath filter

We recommend changing the sheath filter assembly every 
six months. Increased debris appearing in an FSC vs SSC plot can 
indicate that the sheath filter needs to be replaced. See Supplies and 
consumables (page 123) for ordering information.

Sheath filter 
components

The following illustration shows the sheath filter components.

Filter base

Quick-disconnect

Sheath line

Vent fitting

Vent line
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Removing the old 
filter

To remove the old filter:

1. Place the cytometer in standby mode.

2. Remove the sheath filter assembly by pressing the 
quick-disconnect on both sides of the filter assembly.

3. Over a sink or beaker:

• Remove the vent line from the filter and set it aside.

• Remove the filter base and set it aside.

4. Discard the used filter assembly in an appropriate receptacle.

Attaching the new 
filter

To attach the new filter:

1. Connect the vent line to the new filter assembly.

Twist to attach.

2. Wrap Teflon® tape around the filter threads, then connect the 
filter to the filter base.

3. Connect the sheath line to the filter assembly by squeezing the 
quick-disconnect.

4. Attach the cytometer fluid line to the filter assembly via the 
quick-disconnect.

5. Direct the vent line into a beaker and press the small button at 
the end of the vent fitting against the side of the beaker until a 
steady stream of fluid empties from the filter.

6. Tilt the filter and verify that no trapped air remains in the 
filter.

7. Repeat steps 5 and 6 as necessary to remove all trapped air.
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Changing the Bal seal
Introduction This topic describes how to replace the Bal seal. 

The sample injection tube Bal seal is a ring that forms a seal with 
the sample tube and ensures proper tube pressurization. 

When to change 
the Bal seal

Over time, the Bal seal becomes worn or cracked and requires 
replacement. Replacement is necessary if a proper seal is not 
formed when a sample tube is installed on the SIP. Indications that 
a proper seal has not formed include:

• The tube will not stay on the SIP without the tube support 
arm.

• When the tube is installed and RUN is pressed on the 
cytometer, the RUN button is orange (not green).

Procedure To replace the Bal seal:

1. Remove the outer sleeve from the sample injection tube by 
turning the retainer counter-clockwise. Slide the outer sleeve 
down and off of the sample injection tube.

Work carefully. The outer sleeve can fall off as you loosen the 
retainer.

Retainer

Outer sleeve

Sample injection tube

Bal seal
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2. Remove the Bal seal by gripping it between your thumb and 
index finger and pulling down.

3. Install the new Bal seal spring-side up.

Ensure that the sample tube O-ring is still in place inside the 
retainer. 

4. Re-install the retainer and outer sleeve over the sample 
injection tube. Push the outer sleeve all the way up into the 
sample injection port and then screw the retainer into place 
and tighten to finger tight. This will seat the Bal seal.

5. Install a sample tube on the SIP to ensure that the outer sleeve 
has been properly installed. 

If the sleeve hits the bottom of the tube, loosen the retainer 
slightly and push the sleeve up as far as it will go. Tighten the 
retainer.
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Changing the sample tube O-ring
Introduction This topic describes how to replace the sample tube O-ring.

The sample tube O-ring, located within the retainer, forms a seal 
that allows the droplet containment vacuum to function properly. 

When to replace 
the O-ring

Replace the O-ring when droplets form at the end of the sample 
injection tube while the vacuum is operating.

Caution

Procedure To change the O-ring:

1. Remove the outer sleeve from the sample injection tube by 
turning the retainer counter-clockwise.

2. Slide the outer sleeve from the retainer.

Caution: Biohazard! Cytometer hardware might be 
contaminated with biohazardous material. Wear suitable 
protective clothing, eyewear, and gloves whenever 
cleaning the cytometer or replacing parts.

Retainer

O-ring
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3. Invert the outer droplet sleeve and allow the O-ring to fall 
onto the benchtop. 

If the O-ring does not fall out initially, hold the O-ring with 
your free hand and slide the outer sleeve to remove the O-ring.

4. Place the new O-ring into the retainer. Make sure the O-ring is 
seated properly in the bottom of the retainer.

5. Replace the outer sleeve in the retainer.

6. Re-install the retainer and the outer sleeve.

7. Install a sample tube on the SIP to ensure that the outer sleeve 
has been properly installed. 

If the sleeve hits the bottom of the tube, loosen the retainer 
slightly and push the sleeve up as far as it will go. Tighten the 
retainer.
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Cleaning or replacing the sheath gasket 
Introduction This topic describes how to clean or replace the gasket of the 

sheath tank lid.

When to change 
the sheath filter

We recommend cleaning the sheath gasket when needed.

Procedure To clean or replace the gasket:

1. Put the cytometer in standby mode.

2. Depressurize the sheath container by pulling up on the vent 
valve.

3. Remove the lid from the sheath tank. 

4. Remove the black gasket from the lid. 

5. Rinse it with water to clean the gasket. 

6. Place the clean gasket or the new gasket on the lid and make 
sure the gasket is seated properly on the lid. 
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5
Optimizing cytometer settings

This chapter covers the following topics:

• Cytometer settings workflow (page 66)

• Verifying the configuration and user preferences (page 68)

• Running a performance check (page 70)

• Setting up an experiment (page 74)

• Creating application settings (page 80)

• Recording compensation controls (page 83)

• Calculating compensation (page 86)
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Cytometer settings workflow
Introduction This topic describes how to optimize cytometer settings. The 

optimization is performed using the Cytometer Setup and 
Tracking, Application Settings, and Compensation Setup features 
of BD FACSDiva software. 

When to optimize 
settings

Before you record data for a sample, optimize the cytometer 
settings for the sample type and fluorochromes used. 

Manual 
compensation

Compensation setup automatically calculates compensation 
settings. If you choose to perform compensation manually, not all 
of the following instructions apply. For detailed instructions, see 
the BD FACSDiva Software Reference Manual.

First-time users If you are performing the procedures in this workflow for the first 
time, you should be familiar with BD FACSDiva software 
concepts: workspace components, cytometer and acquisition 
controls, and tools for data analysis.

For additional details, see the BD FACSDiva Software Reference 
Manual.

Before you begin Start the cytometer and perform the setup and QC procedures. See 
Cytometer setup (page 35).
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Workflow for 
optimizing settings

Cytometer optimization consists of the following steps.

Note:  Application settings are optional and do not have to be 
saved for the experiments. However, they are useful for optimizing 
cytometer settings.

About the 
examples

The examples in this chapter use a 4-color bead sample with the 
following fluorochromes:

• FITC

• PE

• PerCP-Cy™5.5

• APC

If you follow this workflow with a different bead sample (or 
another sample type), your software views, data plots, and 
statistics might differ from the example. Additionally, you might 
need to modify some of the instructions in the procedure.

The information shown in italics is for example only. You can 
substitute your own names for folders and experiments.

Step Description

1 Verifying the configuration and user preferences (page 68)

2 Running a performance check (page 70)

3 Setting up an experiment (page 74)

4 Creating application settings (page 80)

5 Recording compensation controls (page 83)

6 Calculating compensation (page 86)
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Verifying the configuration and user preferences
Introduction This topic describes how to verify the cytometer configuration and 

user preferences before you create an experiment.

Procedure To verify the configuration and preferences before you create an 
experiment:

1. Select Cytometer > View Configurations and verify the current 
configuration. 

Your cytometer might include only the base configuration 
when your cytometer is installed. You can create additional 
configurations later as needed. 

In this example, the cytometer configuration must include the 
following parameters: FITC, PE, PerCP-Cy5.5, and APC.

Caution! To obtain accurate data results, the current 
cytometer configuration must reflect your flow 
cytometer optics. 
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2. If you need to select a configuration other than the current 
configuration:

a. In the Configurations tab, select a configuration. 

b. Click Set Configuration.

c. Click OK. 

d. Verify that the configuration you just set matches your flow 
cytometer optics.

3. Click OK to close the Cytometer Configuration window.

4. Select File > Exit to close CS&T.

5. Select Edit > User Preferences. 

6. Click the General tab and select the Load data after recording 
checkbox.

See the BD FACSDiva Software Reference Manual for more 
information about cytometer configurations and user preferences.

Next step Running a performance check (page 70)

More information • Setting up an experiment (page 74)
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Running a performance check
Introduction This topic describes how to run a performance check as part of 

quality control.

Overview The CS&T application is designed to monitor performance on a 
daily basis and to optimize laser delay. 

Running a performance check on a regular basis provides a 
standard for monitoring changes in performance due to 
degradation of laser power, aging of PMTs, and other potential 
cytometer service issues. Performance results are also affected by 
fluidics performance. We strongly recommend following the 
fluidics maintenance procedures as described in Cleaning the 
fluidics (page 51).

Considerations Some BP filters might not be normalized to CS&T settings. In this 
case, CS&T will generate Qr and Br numbers that are not 
comparable from instrument to instrument. They are however, still 
trackable on one cytometer. Part of the process for optimizing 
cytometer settings includes verifying PMT voltages set by CS&T 
for all parameters. Carefully examine any channel with a non-
CS&T normalized filter.

Before you begin Define the performance baseline for any configuration before 
running a performance check. See Custom configurations and 
baselines (page 47).
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Procedure To run a performance check:

1. Select Cytometer > CST.

2. Verify that the bead lot information under Setup Beads 
matches the Cytometer Setup and Tracking bead lot.

3. Verify that the cytometer configuration is correct for your 
experiment.

If the cytometer is not set to the correct configuration:

a. Click Select Configuration in the Setup Control window.

b. Select the correct configuration from the list.

c. Click Set Configuration and then click OK.

4. Verify that the current configuration has a valid baseline 
defined.

If not, see the BD Cytometer Setup and Tracking Application 
Guide for more information on defining a baseline.

5. Prepare the CS&T beads according to the technical data sheet 
provided with the beads or available on the BD Biosciences 
website (bdbiosciences.com).

6. Install the bead tube onto the SIP.
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7. In the Setup Control window, select Check Performance from 
the Characterize menu.

8. Click Run.

9. Ensure that Fine Adjust is set to 250, press Run, and Low.

Plots appear under the Setup tab and the performance check is 
run. The performance check takes approximately 5 minutes to 
complete.

10. Once the performance check is complete, click View Report.

11. Verify that the cytometer performance passed.

In the Setup tab, the cytometer performance results should 
have a green checkbox displayed and the word Passed next to 
it.
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If any parameters did not pass, see the BD Cytometer Setup 
and Tracking Application Guide for troubleshooting 
information.

12. Select File > Exit to close the CS&T window and return to the 
BD FACSDiva interface.

The CST Mismatch dialog opens.

Click the Details button to verify which cytometer settings will 
be updated.

13. Click Use CST Settings.

By selecting Use CST Settings, the laser delay, area scaling, and 
other cytometer settings will be updated to the latest settings 
from the performance check.

Next step Continue the optimization of your cytometer for an experiment or 
sample type as described in Setting up an experiment (page 74).
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Setting up an experiment
Introduction This topic describes how to create an experiment in a new folder, 

specify the parameters of the experiment, and add compensation 
tubes.

Creating an 
experiment

To create an experiment:

1. Click the buttons on the Workspace toolbar to display the 
following windows as needed:

• Browser 

• Cytometer 

• Inspector 

• Worksheet 

• Acquisition Dashboard 

When you add elements or make selections in the Browser, the 
Inspector displays details, properties, and options that 
correspond to your selection.

2. Click the New Folder button on the Browser toolbar to add a 
new folder. 

3. Click the folder and rename it MyFolder.

4. Click MyFolder, then click the New Experiment button on the 
Browser toolbar. 

a. Click the new experiment in the Browser and rename it 
MyExperiment.
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5. Select MyExperiment in the Browser. 

The Inspector displays details for the experiment. 

Specifying 
parameters

To specify the parameters for the new experiment:

1. Select Cytometer Settings for the experiment in the Browser.
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Cytometer settings appear in the Inspector.

2. Make sure the parameters you need appear on the Parameters 
tab in the Inspector.

If more than one parameter is available for a particular PMT, 
you might have to select the one you need from a menu. For 
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example, you can set Detector F for the blue laser as FITC or 
BB515.

a. Click the Parameter name to display the available 
fluorochromes in the Parameters list. 
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b. Select the specific parameter from the menu. Your selection 
appears as the selected parameter.

c. For this example, select FITC from the menu.

3. Delete any unnecessary parameters.
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a. Click the selection button (to the left of the parameter 
name) to select the parameter.

b. Click Delete. 

The parameter is deleted.
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Creating application settings
Introduction This topic describes how to create application settings.

About application 
settings

Application settings are associated with a cytometer configuration 
and include the parameters for the application, area scaling values, 
PMT voltages, and threshold values, but not compensation. Each 
time a performance check is run for a configuration, the 
application settings associated with that configuration are updated 
to the latest run.

Using application settings provides a consistent and reproducible 
way to reuse cytometer settings for commonly used applications.

You can include area scaling adjustment in your application 
settings. See Adjusting area scaling (page 117) for more 
information.

Before you begin Perform the cytometer setup procedure and run a performance 
check for the configuration that will be used for the application.

Procedure To create application settings:

1. In the open experiment, right-click Cytometer Settings in the 
Browser, then select Application Settings > Create Worksheet.

A second global worksheet is added with the plots created 
according to the selections in the Parameters tab. 
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Use the gray boxes and crosshairs to guide your optimization.

2. Load the unstained control tube onto the cytometer.

3. In the Cytometer window, optimize the PMT voltages for the 
application.

• Optimize the FSC and SSC voltages to place the population 
of interest on scale.

• Optimize the FSC threshold value to eliminate debris 
without interfering with the population of interest.

• If needed, increase the fluorescence PMT voltages to place 
the negative population within the gray boxes. Align the 
center of the negative population with the crosshair visible 
in the gray box.

Note:  Do not decrease the fluorescence PMT voltages. Doing 
so can make it difficult to resolve dim populations from the 
negative population.

4. Unload the unstained control tube from the cytometer.

5. Load the multicolor sample onto the cytometer or load single-
color control tubes and verify each fluorochrome signal 
separately.
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6. Verify that the positive populations are on scale.

If a positive population is off scale, lower the PMT voltage for 
that parameter until the positive population can be seen 
entirely on scale.

7. Unload the multicolor sample.

8. Place a tube containing DI water on the SIP and put the 
cytometer on standby.

9. (Optional) Save the application settings by right-clicking 
Cytometer settings in the Browser, then selecting Cytometer 
Settings > Save.

10. In the Save Cytometer Settings dialog, enter a descriptive name 
for the settings.

11. Click OK.

The application settings are saved to the catalog.

Next step Recording compensation controls (page 83)
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Recording compensation controls
Introduction This topic describes how to create and record compensation 

controls using the Compensation Setup feature of BD FACSDiva 
software and an experiment with optimized settings.

Creating 
compensation 
tubes

To create compensation control tubes:

1. Select Experiment > Compensation Setup > 
Create Compensation Controls.

The Create Compensation Controls dialog opens.

For this bead example, you do not need to provide non-generic 
tube labels.

2. Click OK.
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Compensation control tubes are added to the experiment. 
Worksheets containing appropriate plots and gates are added 
for each compensation tube.

Recording 
compensation 
settings

To record compensation settings:

1. Press RUN and HIGH on the cytometer fluid control panel.

2. Install the unstained control tube onto the SIP. 

3. Expand the Compensation Controls specimen in the Browser.

4. Set the current tube pointer to the unstained control tube (it 
becomes green), then click Acquire Data in the Acquisition 
Dashboard.

5. Verify that the population of interest is displayed appropriately 
on the FSC vs SSC plot and adjust voltages if necessary.
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Since the application settings have been optimized for your 
sample, the cytometer settings should not require adjustment 
other than the changing of FSC and SSC voltages to place the 
beads on scale.

6. Adjust the P1 gate to surround only the singlets.

7. Right-click the P1 gate and select Apply to All Compensation 
Controls. 

The P1 gate on each stained control worksheet is updated with 
your changes.

8. Click Record Data.

9. When recording is finished, remove the unstained control tube 
from the cytometer.

10. Click Next Tube.

11. Install the next tube onto the cytometer and repeat steps 8 
through 10 until data for all stained control tubes has been 
recorded.

12. Double-click the first stained control tube to display the 
corresponding worksheet.

Caution! Do not change the PMT voltages after the 
first compensation control has been recorded. In 
order to calculate compensation, all controls must 
be recorded with the same PMT voltage settings. If 
you need to adjust the PMT voltage for a 
subsequent compensation control, you must record 
all compensation controls again.
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13. Verify that the snap-to interval gate encompasses the positive 
population.

14. Repeat steps 12 and 13 for the remaining compensation tubes.

Next step After you have recorded data for each single-stained control, 
calculate compensation as described in Calculating compensation 
(page 86).

Calculating compensation
Introduction This topic describes how to calculate compensation.

Before you begin Before you can calculate compensation, you need to record the 
data for each single-stained control.

Procedure To calculate compensation:

1. Select Experiment > Compensation Setup > Calculate 
Compensation.

Note:  If the calculation is successful, a dialog prompts you to 
enter a name for the compensation setup. The default name is 
year/month/day/time.
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2. Enter a setup name and click Link & Save.

The compensation is linked to the cytometer settings and saved 
to the catalog.

To help track compensation setups, include the experiment 
name, date, or both in the setup name.

The compensation setup is linked to the MyExperiment 
cytometer settings, and subsequent acquisitions in 
MyExperiment are performed with the new compensation 
settings.

We recommend that you always visually and statistically inspect 
automatically calculated spectral overlap values. The means of the 
positive controls should be aligned with the means of the negative 
controls.

More information • Recording compensation controls (page 83)
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6
Recording and analyzing data

This chapter covers the following topics:

• Data recording and analysis workflow (page 90)

• Preparing the workspace (page 91)

• Recording data (page 92)

• Analyzing data (page 95)

• Reusing an analysis (page 101)
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Data recording and analysis workflow
Introduction This topic outlines the basic acquisition and analysis tasks using 

BD FACSDiva software.

About the 
examples

The examples in this chapter are from two 4-color bead samples 
with the following fluorochromes:

• FITC

• PE

• PerCP-Cy5.5

• APC

If you use a different sample type or if you have skipped the 
optimization steps in Optimizing cytometer settings (page 65), 
your software window content, names of folders and experiments, 
and your data plots and statistics might differ from those shown 
here. You might also need to modify some of the instructions in the 
procedure.

For additional details on completing some of the following steps, 
see the BD FACSDiva Software Reference Manual.

This procedure builds on the results obtained in Optimizing 
cytometer settings (page 65).

Workflow for 
recording and 
analyzing data

Recording and analyzing data consists of the following steps.

Step Description

1 Preparing the workspace (page 91)

2 Recording data (page 92)

3 Analyzing data (page 95)

4 Reusing an analysis (page 101)
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Preparing the workspace
Introduction This topic describes how to prepare the workspace and apply 

application settings to your experiment before recording data.

Procedure To prepare the workspace:

1. Using the Browser toolbar, create a new specimen in 
MyExperiment and rename it FourColorBeads.

2. Create two tubes for the FourColorBeads specimen. Rename 
the tubes Beads_001 and Beads_002.

3. Expand the Global Worksheets folder in MyExperiment to 
access the default global worksheet, and rename the worksheet 
MyData.

4. On the MyData worksheet, create the following plots for 
previewing the data:

• FSC vs SSC

• FITC vs PE

• FITC vs PerCP-Cy5.5

• FITC vs APC

Applying saved 
application settings 
to a new 
experiment

When applications settings are applied to an experiment, the 
cytometer settings are updated with the parameters included in the 
application settings, optimized PMT voltages, threshold settings, 
area scaling factors, and window extension values.

To apply saved application settings to your experiment:

1. Right-click the experiment-level Cytometer Settings and select 
Application Settings > Apply.
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2. In the Application Settings catalog, select the application 
settings file you saved previously and click Apply.

If the parameters are not the same, a mismatch dialog opens. 

• Click Overwrite to update all settings.

• Click Apply to change only the common parameters.

For more information, see the BD FACSDiva Software 
Reference Manual.

The cytometer settings are renamed application settings and the 
cytometer settings icon in the Browser changes.

More information • Creating application settings (page 80)

• Recording data (page 92)

Recording data
Introduction This topic provides an example of how to preview and record data 

for multiple samples.

Before you begin Prepare the sample tubes.

Recording data To record data:

1. Press RUN and HIGH on the cytometer fluid control panel.

2. Install the first sample tube onto the SIP.

3. Set the current tube pointer to Beads_001. 

4. Click Acquire Data in the Acquisition Dashboard to begin 
acquisition. 
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5. While data is being acquired:

a. Draw a gate around the singlets on the FSC vs SSC plot.

b. Rename the P1 gate to Singlets.

c. Use the Inspector to set the other plots to show only the 
singlet population by selecting the Singlets checkbox.

6. Click Record Data.

7. When event recording has completed, remove the first tube 
from the cytometer. 

The MyData worksheet plots should look like the following.
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8. Install the second sample tube onto the SIP.

9. Set the current tube pointer to Beads_002.

10. Click Acquire Data to begin acquisition.

11. Before recording, preview the data on the MyData worksheet 
to verify that all expected populations are visible and the data 
is similar to the previous sample.

12. Click Record Data.

13. When event recording has completed, remove the second tube 
from the cytometer.

14. If you are recording more than two tubes, repeat steps 8 
through 13 for the remaining tubes.

15. Print the experiment-level cytometer settings by right-clicking 
the Cytometer Settings icon in the Browser and selecting Print.

16. Install a tube of DI water onto the SIP. 

17. Place the cytometer in standby mode.

More information • Analyzing data (page 95)
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Analyzing data
Introduction This topic describes how to analyze recorded tubes by creating 

plots, gates, a population hierarchy, and statistics views on a new 
global worksheet. 

Analyzing data To analyze data:

1. Use the Browser toolbar to create a new global worksheet. 
Rename it MyDataAnalysis.

2. Create the following plots on the MyDataAnalysis worksheet:

• FSC vs SSC

• FITC vs PE

• FITC vs PerCP-Cy5.5

• FITC vs APC

3. Create a population hierarchy and a statistics view, and set 
them below the plots on the worksheet.

• Right-click any plot and select Show Population Hierarchy. 

• Right-click any plot and select Create Statistics View. 

4. Set the current tube pointer to Beads_001.

5. Draw a gate around the singlets on the FSC vs SSC plot. 

6. Use the population hierarchy to rename the population 
Singlets.
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7. Select all plots except the FSC vs SSC plot, and use the Plot tab 
in the Inspector to specify to show only the singlet population.

8. Select all plots, and click the Title tab in the Inspector. 
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9. Select the Tube and Populations checkboxes to display their 
names in plot titles.

10. On all fluorescence plots:

• Make all plots biexponential. Select all fluorescence plots 
and select the X Axis and Y Axis checkboxes in the Plot tab 
of the Inspector.
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• In the FITC vs PE plot, draw a gate around the 
FITC-positive population. Name the population FITC 
positive in the population hierarchy.

• In the FITC vs PE plot, draw a gate around the PE-positive 
population. Name the population PE positive in the 
population hierarchy.

• In the FITC vs PerCP-Cy5.5 plot, draw a gate around the 
PerCP-Cy5.5-positive population. Name the population 
PerCP-Cy5.5 positive in the population hierarchy.

• In the FITC vs APC plot, draw a gate around the APC-
positive population. Name the population APC positive in 
the population hierarchy.

11. Format the statistics view.

a. Right-click the statistics view and select Edit Statistics 
View.

b. Click the Header tab and select the Specimen Name and 
Tube Name checkboxes.

c. Click the Populations tab and select all populations except 
All Events. Clear the %Parent, %Total, and #Events 
checkboxes.

d. Click the Statistics tab and select the mean for each of the 
fluorescence parameters.

Status: Released EFFECTIVEDocument: 23-17876-00 Doc Type: ZLU
Change #: 500000105151Revision: 01

Version: AUsage: Production Usage Classification: ConfidentialPrint Date: 19-Jan-2018 05:14:57 GMT Standard Time
Valid From: 05-Sep-2017 To: 31-Dec-9999 Doc Part: EN



Chapter 6: Recording and analyzing data 99

e. Click OK.

12. Print the analysis.
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Your global worksheet analysis objects should look like the 
following.
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More information • Reusing an analysis (page 101)

Reusing an analysis
Introduction This topic describes how to use a global worksheets to apply the 

same analysis to a series of recorded tubes. Once you define an 
analysis for a tube, you can use it to analyze the remaining tubes in 
the experiment. After viewing the data, print the analysis or save it 
to a normal worksheet.

Reusing an analysis To reuse the analysis:

1. Set the current tube pointer to the Beads_002 tube.

2. View the Beads_002 data on your analysis worksheet. Adjust 
the gates as needed.

Adjustments apply to subsequent tubes viewed on the 
worksheet. To avoid altering a global worksheet, save an 
analysis to a normal worksheet, then make adjustments on the 
normal worksheet.

3. Print the analysis.

Saving the analysis When you perform analysis with a global worksheet, the analysis 
does not save with the tube.

If you define your analysis on a global worksheet before recording 
data, you can specify to automatically save the analysis after 
recording data. You set this option in User Preferences.

To save a copy of the analysis with a tube:

1. Expand the MyDataAnalysis global worksheet icon in the 
Browser.
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2. Right-click its analysis and select Copy.

3. Click the Worksheets View button on the Worksheet toolbar to 
switch to the normal worksheet view.

4. Select Worksheet > New Worksheet to create a new normal 
worksheet.

5. Right-click the Beads_001 tube icon in the Browser, and select 
Paste.

The analysis objects from the MyDataAnalysis global 
worksheet are copied to the Beads_001_Analysis normal 
worksheet. Double-click the Beads_001 tube in the Browser to 
view the analysis.

Applying an 
analysis to normal 
worksheets

You can apply the global worksheet analysis to multiple tubes (on 
a single normal worksheet) by selecting multiple tubes before 
pasting the analysis. Ensure that you collapse all tube elements in 
the Browser before you paste them to multiple tubes.

More information • Analyzing data (page 95)
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7
Troubleshooting

This chapter covers the following topics:

• Cytometer troubleshooting (page 104)

• Electronics troubleshooting (page 112)
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Cytometer troubleshooting
Introduction This topic describes possible problems and recommended solutions 

for BD LSRFortessa X-30, BD LSRFortessa X-50, BD LSRFortessa 
X-30 Dual, BD FACSymphony A3, BD FACSymphony A5, and 
BD FACSymphony A3 Dual flow cytometer issues.

Droplets are visible 
on the SIP Possible causes Recommended solutions

Worn O-ring in the retainer Replace the O-ring. See Changing the 
sample tube O-ring (page 62).

Outer sleeve is not seated in 
the retainer

1. Loosen the retainer.

2. Push the outer sleeve up into the 
retainer until seated.

3. Tighten the retainer.

Outer sleeve is not on the 
sample injection tube

Replace the outer sleeve.

1. Loosen the retainer.

2. Slide the outer sleeve over the 
sample injection tube until it is 
seated.

3. Tighten the retainer.

Waste line is pinched, 
preventing proper aspiration

Check the waste line.

Waste tank is full Empty the waste tank.

Droplet containment vacuum 
is not functioning

Call your BD service representative.

The mode is not set to HTS. Change the mode to HTS by pressing 
down the Mode button for more than 
3 seconds.
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Sample tube not 
fitting on SIP

Rapid sample 
aspiration

No events in 
acquisition display 
and RUN button is 
green

Possible causes Recommended solutions

Sample tube other than 
Falcon® tubes used

Use Falcon 12 x 75-mm sample tubes. 
See Equipment (page 126).

Worn Bal seal Replace the Bal seal. See Changing the 
Bal seal (page 60).

Sample tube is cracked Transfer contents to a new tube.

Possible causes Recommended solutions

Support arm is to the side Place the support arm under the 
sample tube.

Droplet containment module 
is failing

Try the solutions in Droplets are 
visible on the SIP (page 104). If the 
issue is not resolved, call your BD 
service representative.

Possible causes Recommended solutions

Threshold is not set to the 
correct parameter (usually 
FSC)

Set the threshold to the correct 
parameter for your application.

Threshold level is too high Lower the threshold level. 

PMT voltage for threshold 
parameter is set too low

Set the PMT voltage higher for the 
threshold parameter. 

Gating issue See the BD FACSDiva Software 
Reference Manual for information on 
setting gates.

Air in the sheath filter Purge the filter. See Removing air 
bubbles (page 39).

Air bubble or debris in the 
flow cell

Prime the fluidics system. See Priming 
the fluidics (page 44).
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No sample in the tube Verify that sample remains in the tube 
and if necessary, add sample to the 
tube or install a new sample tube.

Sample is not mixed properly Mix the sample to suspend the cells.

Waste tank is full Empty the waste tank.

PMT voltages set too low or 
too high for display 
parameter

Adjust the PMT voltages.

Too few events are displayed Increase the number of events to 
display.

Sample injection tube is 
clogged

Remove the sample tube to allow 
backflushing.

If the event rate is still erratic, clean 
the sample injection tube. See Cleaning 
the fluidics (page 51).

Bal seal is worn Replace the Bal seal. See Changing the 
Bal seal (page 60).

Instrument is not warmed up Wait 30 minutes for the instrument to 
warm up.

Laser delay is set incorrectly Adjust the laser delay settings. See 
Manual settings (page 113).

Laser is not functioning Verify the malfunction by changing the 
threshold to an alternative laser while 
running the appropriate sample. If 
unsuccessful, contact BD Biosciences.

Tube is cracked or misshapen Replace the sample tube.

Possible causes Recommended solutions
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No events in 
acquisition display 
and RUN button is 
orange

No fluorescence 
signal

Possible causes Recommended solutions

RUN is not activated Press the RUN button.

Sample tube is not installed 
or is not properly seated

Install the sample tube correctly on the 
SIP.

Sample tube is cracked Replace the sample tube.

Waste tubing line is 
disconnected from the waste 
container tank 

Connect the waste tubing line to the 
waste container tank.

Sheath container is not 
pressurized

 Ensure that the sheath container lid 
and all connectors are securely 
seated.

 Inspect the sheath container O-ring 
inside the lid and replace it if 
necessary. See Cleaning or 
replacing the sheath gasket 
(page 64)

Bal seal is worn Replace the Bal seal. See Changing the 
Bal seal (page 60).

Air leak at sheath container Ensure that the sheath container lid 
and all connectors are securely seated.

Sheath container is empty Fill the sheath container.

Air in sheath filter Purge the filter. See Removing air 
bubbles (page 39).

Possible causes Recommended solutions

Incorrect fluorochrome 
assignment

Make sure that the cytometer 
configuration in the software matches 
the optical filters in the cytometer and 
the configuration is as expected.

Laser is not functioning Call your BD service representative.
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No signal in red 
laser channels 
(when red laser is 
installed)

High event rate

Low event rate

Possible causes Recommended solutions

Incorrect laser delays due to 
a change in the sheath tank 
fluid level

 Check the fluid level in the sheath 
tank and refill if necessary.

 Adjust the laser delay settings. See 
Manual settings (page 113).

Possible causes Recommended solutions

Air bubbles in the sheath 
filter or flow cell

Remove the air bubbles. See Removing 
air bubbles (page 39).

Threshold level is too low Increase the threshold level. See the 
BD FACSDiva Software Reference 
Manual for instructions.

PMT voltage for the 
threshold parameter is set 
too high

Set the PMT voltage lower for the 
threshold parameter. See the 
BD FACSDiva Software Reference 
Manual for instructions.

Sample is too concentrated Dilute the sample.

Sample flow rate is set to 
HIGH

Set the sample flow rate to MED or 
LOW.

Possible causes Recommended solutions

Threshold level is too high Lower the threshold level. See the 
BD FACSDiva Software Reference 
Manual for instructions.

Air bubble or debris in the 
flow cell

Prime the fluidics system. See Priming 
the fluidics (page 44).

PMT voltage for the 
threshold parameter is set 
too low

Set the PMT voltage higher for the 
threshold parameter. See the 
BD FACSDiva Software Reference 
Manual for instructions.
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Erratic event rate

Sample is not adequately 
mixed

Mix the sample to suspend the cells.

Sample is too diluted Concentrate the sample. If the flow 
rate setting is not critical to the 
application, set the flow rate switch to 
MED or HIGH.

Sample injection tube is 
clogged

Remove the sample tube to allow 
backflushing.

If the event rate is still erratic, clean 
the sample injection tube. See Cleaning 
the fluidics (page 51).

Possible causes Recommended solutions

Possible causes Recommended solutions

Sample tube is cracked Replace the sample tube.

Air bubble or debris in the 
flow cell

Prime the fluidics system. See Priming 
the fluidics (page 44).

Bal seal is worn Replace the Bal seal. See Changing the 
Bal seal (page 60).

Sample injection tube is 
clogged

Remove the sample tube to allow 
backflushing.

If the event rate is still erratic, clean 
the sample injection tube. See Cleaning 
the fluidics (page 51).

Contaminated sample Prepare the specimen again. Ensure 
that the tube is clean.

Sheath filter is dirty Replace the filter. See Changing the 
sheath filter (page 58).
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Distorted scatter 
parameters

Excessive amount 
of debris in display

Possible causes Recommended solutions

Cytometer settings are 
improperly adjusted

Optimize the scatter parameters. See 
the BD FACSDiva Software Reference 
Manual for instructions.

Air bubble in the sheath filter 
or flow cell

Purge the air from the filter. See 
Removing air bubbles (page 39).

Flow cell is dirty Flush the system. See Flushing the 
system (page 54).

Air leak at sheath container Ensure that the sheath container lid is 
tight and all connectors are secure.

Hypertonic buffers or 
fixative

Replace the buffers or fixative.

Possible causes Recommended solutions

Threshold level is too low Increase the threshold level.

Sheath filter is dirty Replace the filter. See Changing the 
sheath filter (page 58).

Flow cell is dirty Flush the system. See Flushing the 
system (page 54).

Dead cells or debris in the 
sample

Examine the sample under a 
microscope.

Sample is contaminated Re-stain the sample. Ensure that the 
tube is clean.

Stock sheath fluid is 
contaminated

Rinse the sheath container with DI 
water, then fill the container with 
sheath fluid from another (or new lot) 
bulk container.
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High CV or poor QC 
results Possible causes Recommended solutions

Air bubble in sheath filter or 
flow cell

 Purge the filter. See Removing air 
bubbles (page 39).

 Prime the fluidics system. See 
Priming the fluidics (page 44).

Sample flow rate is set too 
high

Set the sample flow rate lower.

Air leak at sheath container Ensure that the sheath container lid is 
tight and all connectors are secure.

Flow cell is dirty Flush the system. See Flushing the 
system (page 54).

Waste tank is pressurized Replace the waste container cap. See 
Replacing the waste container cap 
(page 56).

Poor sample preparation Repeat sample preparation.

Sample was not diluted in the 
same fluid as the sheath fluid

Dilute the sample in the same fluid as 
you are using for sheath.

Old or contaminated QC 
particles

Make new QC samples and perform 
the quality control procedure again.

Instrument is not warmed up Wait 30 minutes for the instrument to 
warm up.

Laser is not functioning Contact BD Biosciences.

Optical alignment problem Contact BD Biosciences.
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Electronics troubleshooting
Introduction This topic describes possible problems and recommended solutions 

for electronics issues.

“Cytometer 
Disconnected” in 
cytometer window

Possible causes Recommended solutions

Cytometer power is off Turn on the cytometer main power.

Communication failure 
between workstation and 
cytometer

1. In BD FACSDiva software, select 
Cytometer > Connect.

2. If connecting does not work, 
restart the cytometer. Turn the 
cytometer off, wait 1 minute, and 
turn on the cytometer main power.

3. If connecting still does not work, 
contact BD Biosciences.

Status: Released EFFECTIVEDocument: 23-17876-00 Doc Type: ZLU
Change #: 500000105151Revision: 01

Version: AUsage: Production Usage Classification: ConfidentialPrint Date: 19-Jan-2018 05:14:57 GMT Standard Time
Valid From: 05-Sep-2017 To: 31-Dec-9999 Doc Part: EN



8
Manual settings 

This chapter covers the following topics:

• About laser delay (page 114)

• Optimizing laser delay (page 115)

• Adjusting area scaling (page 117)
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About laser delay
Introduction This topic describes how to manually set the laser delay if you are 

not using CS&T for cytometer setup and tracking.

About laser signal 
delay

Sample interrogation takes place within the cuvette flow cell. Laser 
light is directed through a series of prisms that focus multiple lasers 
on the event stream at different positions. This allows optimal 
detection of fluorescent signals from each laser with minimal cross-
contamination from the other beams.

For example, in a four-laser system, the blue laser intercepts the 
stream first, followed by the violet, UV, and red lasers. Because the 
laser signals are spatially separated, there is a slight delay between 
the detection of each laser’s signal.

The laser delay setting in BD FACSDiva software is used to re-align 
the signals so they can be measured and displayed on the same time 
scale. Signals are aligned with respect to the blue laser, so the blue 
laser will have a 0 delay value, and the red laser will have the 
longest delay.

Time

Red

Event intercepts blue laser
Event intercepts violet laser
Event intercepts UV laser

Event intercepts red laser
Event intercepts yellow-green laser*

Yellow-green

*The yellow-green laser is only available through the BD special order research program.

Blue

UV

Violet
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Optimizing laser delay
Introduction This topic describes how to optimize the laser delay using 

BD FACSDiva software. 

Before you begin To optimize the delay for a given laser, you must acquire events 
from a sample with a fluorescence signal excited by that laser. 
Follow the procedures in Recording and analyzing data (page 89), 
for sample optimization and acquiring data.

Procedure To optimize laser delay:

1. While acquiring data from your sample, create a histogram to 
show the fluorescence signal excited by the laser for which the 
delay is to be optimized.

2. In the Acquisition Dashboard, set the Events to Display to 500 
events.

3. Click the Laser tab in the Cytometer window. 

Window extension and laser delay values are displayed in 
microseconds (µs).

4. Set the Window Extension value to 0 µs.
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5. Set an initial laser delay value only for the laser you are 
optimizing.

• If you are optimizing the violet laser, set its delay to –35 µs.

• If you are optimizing the UV laser, set its delay to –65 µs.

• If you are optimizing the red laser, set its delay to 65 µs.

• If you are optimizing the blue laser, set its delay to 0 µs.

• If you are optimizing the yellow-green laser, set its delay to 
35 µs.

6. While observing the positive events on the histogram, adjust 
the laser delay in 1-µs increments. You might need to adjust 
the delay above or below the initial setting.

Choose the setting that moves the events farthest to the right 
(highest fluorescence intensity).

7. Draw an interval gate on the histogram for the positive events. 

8. Create a statistics view to display the mean fluorescence 
intensity (MFI) of the gated population. 

9. While observing the MFI for the gated population, adjust the 
laser delay in 0.1-µs increments within a range of 2.0 µs of the 
setting obtained in step 6. 

Preserve the setting that maximizes the fluorescence intensity.

10. Reset the Window Extension to 10 µs.
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Adjusting area scaling
Introduction This topic describes how to manually adjust the area scaling on 

your cytometer if necessary for your application. The area scaling 
is automatically set in CS&T. Depending on the size of your target 
particle, you might need to adjust the area scaling manually. Larger 
particles are more likely to require an area scaling adjustment.

About area scaling The area of a pulse is calculated by BD FACSDiva using measured 
height and width measurements. It is sometimes important to 
verify that the area calculation and the height measurement are 
equivalent by adjusting the factor applied to the area. The required 
area scaling factor changes based on sheath pressure and particle 
size. 

About this example The following example describes how to adjust area scaling for an 
experiment which uses only the 488-nm laser and the 640-nm 
laser. You must adjust area scaling for all lasers used in your 
experiment. To adjust the other lasers, add a parameter and the 
corresponding plots from that laser to the procedure.

Procedure To adjust area scaling:

1. Open an existing experiment, or create a new experiment in 
the Browser.

2. Create a new specimen by clicking the New Specimen button 
on the Browser toolbar.
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3. In the Inspector, click the Parameters tab and select the H 
checkbox to select the height for each parameter.

4. On the global worksheet, create the following plots and 
histograms:

• FSC vs SSC dot plot

• FSC-H and FSC-A histogram

• FITC-H and FITC-A histogram

• APC-H and APC-A histogram

5. Create a P1 gate in the FSC vs SSC plot, and show only the P1 
population in all histograms.
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6. Create three statistic views showing the following:

• FSC-H and FSC-A means for P1

• FITC-H and FITC-A means for P1

• APC-H and APC-A means for P1

Your worksheet should look similar to the following figure.

7. Expand the new specimen, then set the current tube pointer to 
tube_001.
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8. Install the FITC-positive control tube onto the loading port 
and click Load in the Acquisition Dashboard.

9. Adjust the FSC and SSC voltages to place the particles on 
scale. 

10. Adjust the P1 gate around the population of interest.

11. Adjust the FSC area scaling.

a. Click the Laser Tab in the Cytometer window.

b. Adjust the FSC area scaling factor until the FSC-A signal 
matches the FSC-H signal:

• Increase the area scaling factor if the FSC-A signal is 
lower than FSC-H.
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• Decrease the area scaling factor if the FSC-A signal is 
higher than FSC-H.

c. View the result of your change in the histograms and 
statistics views.

12. Adjust the blue laser area scaling factor until the FITC-A signal 
matches the FITC-H signal, if needed.

13. Unload the FITC-positive control tube, then load the APC-
positive control tube.
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14. Adjust the red laser area scaling factor until the APC-A signal 
matches the APC-H signal, if needed.
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9
Supplies and consumables

This chapter covers the following topics:

• Ordering information (page 124)

• Beads (page 124)

• Reagents (page 125)

• Equipment (page 126)
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Ordering information
To order spare parts and consumables from BD Biosciences:

• Within the US, call (877) 232-8995.

• Outside the US, contact your local BD Biosciences customer 
support representative.

Worldwide contact information can be found at 
bdbiosciences.com.

Beads
Introduction This topic lists the QC and CS&T beads available.

QC particles

Particle Laser Supplier Catalog No.

SPHERO™ Rainbow Calibration 
Particles (8 peaks)

All BD Biosciences 559123

SPHERO™ Ultra Rainbow 
Fluorescent Particles (single peak)

All Spherotech, Inc. URFP-30-2

BD™ DNA QC Particles Blue (488 nm) BD Biosciences 349523
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CS&T beads

Reagents

Bead Laser Supplier Catalog No.

BD FACSDiva™ 
CS&T research 
beads

 UV (355 nm)

 Violet (405 nm)

 Blue (488 nm)

 Red (637 nm)

 Yellow-green (561 nm)

BD Biosciences  655050 
(50 tests)

 655051 
(150 tests)

Reagent Supplier Catalog No.

BD FACSFlow™ sheath fluid BD Biosciences 342003 

BD FACS™ sheath solution 
with surfactant (recommended 
for use with the HTS option)

BD Biosciences 336524

Monoclonal antibodies BD Biosciences See the BD Biosciences 
Product Catalog or the 
BD Biosciences website 

(bdbiosciences.com)

BD FACS™ lysing solution BD Biosciences 349202

BD™ FACSRinse solution BD Biosciences 340346
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Equipment

BD FACSClean solution BD Biosciences 340345

Dyes and fluorochromes BD Biosciences, Life 
Technologies, or Sigma

–

Chlorine bleach 
(5% sodium hypochlorite)

Clorox® or other major 
supplier (to ensure that the 
bleach is at the correct 
concentration and free of 
particulate matter)

–

Reagent Supplier Catalog No.

Equipment item Supplier Catalog No.

Bal seal BD Biosciences 343509

O-ring, sample tube 343615

Sheath filter assembly 34364507

Falcon polystyrene test tubes, 12 x 75-mm Corning  352008
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A
acridine orange (AO) 51
air bubbles, removing 39
alarm

waste container 30
analysis

data 90
immunophenotyping 95
reusing 101
saving 101

AO See acridine orange
application settings

applying 91
creating 80

area scaling 117
arm, tube support 28
aspiration (sample), rapid 105
assistance, technical 13

B
Bal seal

ordering 126
replacing 60

bandpass (BP) filters
detector array placement 32

BD FACSClean solution 126
BD FACSDiva software See software
BD FACSFlow sheath fluid 125
BD FACSFlow solution 39
BD FACSFlow supply system 36, 53

BD FACSRinse solution 52
BD High Throughput Sampler (HTS) 29
blank optical holders 45
bleach 50, 126
BP See bandpass filters
bubbles, removing air 40
buttons

fluid control 24
sample flow rate control 25

C
calculating compensation 86
capacity, waste container 30
cleaning solutions 50
compensation

calculating 86
control tubes 83
recording settings 84

components
sheath container shown 38
sheath filter shown 58
waste container shown 42

computer system, about 33
configuration

BD FACSDiva 68
containers

sheath 30, 37
waste 30, 42, 43

control panel, cytometer 22
controls

fluidics 22
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single-stained 67, 90
conventions

safety symbols 11
creating

analysis objects 95
global worksheets 91
statistics view 95

CS&T particles 125
cuvette flow cell 114
CV, troubleshooting 111
cytometer 18

configuration 46, 68
disconnect error 112
setup 66
starting 36
troubleshooting 104

D
DAPI, cleaning after using 51
data

analyzing 90, 95
gating 95
recording 90, 92

debris, excessive 110
delay, laser 114
detector arrays 31
detectors 33
digital data 18
Diva software See software
droplet containment system 29

E
electronics

troubleshooting 112
event rate

erratic 109
high 108
low 108
zero 105, 107

excessive debris 110
experiments

creating 74
immunophenotyping 91
sample optimization 74
specifying parameters 75

F
FACSFlow sheath fluid 125
FACSFlow solution 39
Falcon tubes 105
filters, optical

bandpass (BP) 32
filters, sheath

attaching new 59
replacing 58

fixed-alignment lasers 18
flow cell

draining 44
flow rate control buttons 25
fluid control buttons

PRIME 24
RUN 24
STANDBY 24

fluidics
description 23
flow rate control 25
flushing system 54
priming 44
removing air bubbles 40
run mode 24
sample injection port (SIP) 28

fluidics controls, cytometer 22
fluidics interconnect 41
fluorescence signal, none 107
fluorochromes

measured 46
flushing the system 54
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G
gating data 95
global worksheets

analyzing data 95
creating 91
previewing data 90, 101

H
hazard symbol definitions 11
High Throughput Sampler (HTS) 29

I
immunophenotyping

analysis 95
experiment 91

L
laser delay

about 114
optimizing 115

lasers
options 31
performance check 70
quality control (QC) particles 124

M
maintenance

Bal seal 60
cytometer shutdown 53
sample tube O-ring 62
schedule 51
scheduled 54
sheath filter 58
system flush 54

mirrors, dichroic longpass (LP) filter 32

O
optic holder 45
optics

components 31
configuration 68, 69
filters 32

optimization, sample 66
ordering spare parts 124
O-ring

ordering 126
replacing 62
worn 104

P
particles 124, 125
performance check 70, 71
photodiode 33
photomultiplier tubes (PMTs) 33
PMT See photomultiplier tubes
polygon/decagon

shown 32
population hierarchy 95
PRIME, fluid control button 24
priming fluidics system 44
propidium iodide (PI) 51

Q
quality control (QC)

particles 124
troubleshooting 111

R
recording

compensation settings 84
compensation tubes 83
data 90, 92

removing air bubbles, filter 40
replacing

Status: Released EFFECTIVEDocument: 23-17876-00 Doc Type: ZLU
Change #: 500000105151Revision: 01

Version: AUsage: Production Usage Classification: ConfidentialPrint Date: 19-Jan-2018 05:14:57 GMT Standard Time
Valid From: 05-Sep-2017 To: 31-Dec-9999 Doc Part: EN



User’s Guide130

Bal seal 60
sample tube O-ring 62
sheath filter 58
waste air filter 56, 64

reusing analyses 101
rinsing solution 52
RUN

button orange 107
fluid control button 24

S
safety symbol definitions 11
safety symbols 11
sample

optimization 66
optimization experiment 74
optimization, single-stained 

controls 67, 90
sample injection port (SIP)

components 28
replacing Bal seal 60
replacing sample tube O-ring 62

sample tube
injection 28
not fitting 105
requirements 105

samples, running 92
saving analyses 101
scatter

parameter distortion 110
setup, cytometer 66
sheath container

components shown 38
defined 30
depressurize 38
preparing 38

sheath filter
components shown 58
ordering 126
removing air bubbles 39

replacing 58
sheath fluid

backflush 29
BD FACSFlow sheath fluid 125

signals, amplifying 33
software

cytometer control 10
version 33

spare parts, ordering 124
STANDBY, fluid control button 24
starting cytometer 36
statistics views 95
support, technical 13

T
technical assistance 13
thiazole orange (TO) 51
TO See thiazole orange
troubleshooting

cytometer 104
electronics 112

tubes
Falcon 105
requirements 105

U
user preferences 69

W
waste air filter

component shown 42
waste container 30

alarm 30
capacity 30
components shown 42
defined 30
emptying 42

window extension 115
workstation, about 33
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